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1.0 Version History  
 
Version 5.1.0.8 (August 19, 2022) 
Windows 11 (32/64 bit) support added 
WPcap has been replaced with Npcap - NOTE that WPcap will be removed with installer and NPcap loaded (silent install) 
Minor fixes (GUI) for License manager, records 
License status is now displayed in License management window 
Fixed import of certain I-device configurations (Siemens 1200/1500) 
 
Version 5.1.0 7 (Apr 4, 2022) 
Updated PN Stack 
Minor fixes to GUI 
 
Version 5.1.0.6 (Mar 14, 2022) 
New feature, license management (online / offline activation),  
New feature, can download latest Manufacturer ID table from options  
fixes to installer, minor fixes 
 
Version 5.1.0.5 (Apr 10, 2021) 
New feature - Echo inputs to outputs, see details in manual 
New feature – VLAN tag can be removed from DCP Browser messages 
Added new MAU types 
Fixed submodule memory crash 
Manual and installer update about Npcap (not supported yet)/ Wireshark 
Updated License manager 
 
Version 5.1.0.4 (Oct 31, 2019) 
Fixed Input Data Element record 
Fixed Column Display (Browser) 
Fixed max IO submodule issue 
Fixed fragmented record data if > 1400 bytes 
Fixed adapter issue if >= 10 adapters in system 
 
Version 5.1.0.3 (May 2, 2019) 
New - PN Stack Update  
Fixed AR breakdown after moderate TCP netload  
Fixed output randomizer (support all bytes) 
Added Reset to Factory mode details to manual 
Fix for PDev Record 
Fix for MRP Check 
 
Version 5.1.0.2 (March 14, 2019) 
New feature ModDiffBlock detection If a Moddiffblock is detected on device startup it will be shown in the alarms window. (This typically 
means a configuration issue/mismatch but could also mean the device is locked by another process)  See troubleshooting section in manual for 
more details 
New feature Support of all reset to factory modes (0,1,2,3,4,8 & 9), in addition to original factory reset (mode 0) 
Updated record decoding and added new records.  (MRP, MauType, Media, etc) 
New PN Stack update 
DCP error fixes and more name checks 
Fixed column display issue 
Fixed DCP browser to allow independent save of NIC info 
Fixed records offset (padding) issue 
New feature TIA V15.1 now supports Auto configuration of devices (if supported), see manual for details 
 
Version 5.1.0.1 (January 3, 2019) – Also see notes under 5.1.0.0 
Updated error handling for network adapters 
More properties information now included with devices (update time, send clock, watchdog time, etc.) 
Tooltip text update 

 
Version 5.1.0.0 (December 7, 2018) 
Listen up sergeant! This is a MAJOR Update - (and Private first class make sure to read the manual) 
Updated PROFINET stack  
Multithreaded functions added 
DCP browser no longer affects the IO cycle  
Adjustable IO display timer (default 32ms up to 1 second) 
Bugfix for offline mode crash 
Fixed GSD directory search for 32/64 bit 
More automatic output settings added (Decrement, Bitwalk, Randomize, All On/Off) 
Send feedback @ www.profinetcommander.com 
Previous versions info – see readme.txt for detailed history breakdown 
Legacy Versions – Prior versions are now considered legacy versions and it is recommended to update.  
 

 
 
 

http://www.profinetcommander.com/
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2.0 Introduction 
 
With PROFINET Commander, users such as engineers, sales, maintenance personnel, integrators, and developers 
can test and build a PROFINET network and the IO Devices connected to it quickly and without PLC programming. 
PROFINET Commander runs as a PROFINET IO controller on a PC with an easy-to-use graphical user interface 
which displays the following information:  

• Configuration information 

• I/O data 

• Parameters 

• Diagnostics and alarms 

• In addition the user can: 

• Read inputs from the devices. 

• Change the output data to the IO devices. 

• Get alarms and diagnostics from the device(s) and network components (switch also PN IO device) 

• Send read and write record calls to the IO devices. 

• Browse the network, set names, IP addresses, flash LEDs and reset to factory settings 
 
Users gain the ability to test and set up a PROFINET IO Device or system from their PC before putting it into 
production.  For developers of PROFINET IO devices, the added benefit of using the tool is simple testing of their 
product for correct operation and diagnostic functionality prior to PROFINET certification testing and final product 
release. 
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Hardware and Software Requirements 
 
The following items are required for the PROFINET Commander application to operate correctly 

  

• PC with Ethernet port  

• Supported OS (Windows 7 Home Premium/Professional/Enterprise/Ultimate SP 1 (32 Bit), Windows 7 
Home Premium/ Professional/Enterprise/Ultimate SP1 (64 Bit), Windows 8.1 Professional/Enterprise), 
both 32 / 64 bit, Windows 10 Home / Professional, both 32 and 64 bit., Windows 11 Home / 
Professional both 32 / 64 bit. 

• TIA Portal V17 update 3 Professional or higher (trial version available online, does not require a 
separate license for configuration with PRO version), V15.1, V14 is also supported with limitations 
(bytes cannot be above 254 per subslot, etc.) 

o TIA V17 can be obtained here.  Only the DVD1 Setup files are required (double-check this is 
the latest version prior to download and download updates) 

o Next download the latest update from here. 

• Npcap 1.60 OEM (bundled and loaded with installer if needed) or higher 

• Visual C++ V2017 Redistributable (bundled and loaded with installer if needed) 

• Visual C++ V2013 Redistributable (bundled and loaded with installer if needed) 

• Visual C++ 2010 SP1 Redistributable (bundled and loaded with installer if needed) 

• .NET 4.8 or higher (bundled and loaded with installer if needed) 
 

3.0 Installation 
 
For installation, make sure you have administrative rights on the PC.  In some cases the installer will start another 
install (Ex Npcap, C++ runtimes).  Make sure to complete the main installer once the other installers have finished. 
 

3.1 Software updates  

 
 
If your PC has an internet connection, you will be notified if there is a software update available which you can 
apply.  You can also check manually by using the updater in the taskbar if needed or for other options right click on 
the updater.  
 
 

4.0 Configuring the PROFINET IO Controller and the Network Overview 
 
Warning: If you have an antivirus scanner / firewall / malware scanner installed on your PC, it may block 
the PN IO communications on the Ethernet port. In this case PROFINET Commander will not be able to 
communicate with the PNIO devices. You may need to disable the firewall or antivirus / malware scanner (or set 
exceptions of possible) to run PROFINET Commander. If this is not possible, another option is to run PROFINET 
Commander on another PC that does not have a firewall / antivirus / malware scanner. 
 
Before using PROFINET Commander as an IO Controller, the following configuration steps must be performed: 

• Select the IP addresses for the PROFINET Commander tool and the connected PROFINET IO 
devices. 

• Use TIA Portal configuration tool to configure the PROFINET Commander controller and devices. 

• Save and compile the controller configuration to create a configuration .XML file. 

• Download the device names to the PROFINET IO devices (either in the configuration tool or in the 
PROFINET Commander DCP Browser). 

• Import the configuration .XML into PROFINET Commander 
 
 
 
 
 
 
 
 

https://support.industry.siemens.com/cs/ww/en/view/109784440
https://support.industry.siemens.com/cs/ww/en/view/109784441
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4.1 Select the IP Addresses 
 
Before starting the configuration process, you should select the IP addresses for the PROFINET Commander tool 
and the PROFINET IO devices that will be connected so that they are all on the same network and have the same 
subnet mask. For example:  

 IP Address Subnet Mask Type 

PROFINET Commander 
tool 

192.168.0.60 255.255.255.0 PROFINET IO 
Controller 

IODevice1 192.168.0.61 255.255.255.0 ET 200SP / IO 
Device 

IODevice2 192.168.0.62 255.255.255.0 Network Switch / IO 
Device 

PC IP address 192.168.0.254 255.255.255.0 PC IP / Different 
than PNC! 

 
If the Ethernet port on your PC is connected to a corporate network, it would be advisable to keep the PROFINET 
network separate. Some options are: 
1. Use the existing Ethernet port: 

• Disconnect the PC from the corporate network and connect it to the PROFINET network. 

• Run PROFINET Commander software. 

• When finished, connect the PC back to the corporate network. 
2. Add a second Ethernet NIC (USB) to the PC: 

• Connect it to the PROFINET network 

• Run PROFINET Commander software. 
 
The setting of the IP address for the PROFINET Commander (PNC) controller is set in the TIA Portal software 
configuration and is separate and different from the Windows IP address (it also does not even need to be on 
the same subnet as the PC, but of course the PN IO devices will need to be on the same as PNC).  If you already 
have IP settings on your adapter make sure that they do not conflict.   
In some rare cases it may be necessary to adjust your network adapter settings and under properties of your 
adapter deselect all protocols so this does not interfere with the software temporarily.   
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4.2 Configuration 
4.2.1 Configure the PROFINET Commander IO Controller and network 
 

a) Start TIA Portal V17 update 4 or higher.  
Create a new project with Start->Create New Project->Create 

b) Click open the project view 
c) Double click on the left “devices and networks” 
d) Under the catalog on the right hand side select PC Systems\Communication modules\PROFINET\PN 

Driver\<part #> (ex: 6ES7 195-3AA00-0YA0) V2.2 (default version in V17), then drag and drop the object 
into the network view window. 

 
 

  

Drag and drop the 
PROFINET Controller 
into the network view 
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e) Next, double click on the PN Controller object in the network view to open the device view  
f) Under communication modules\PROFINET\Interface Submodules double click the Windows object to add 

the network interface of the controller. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Drag and drop the interface 
submodule to the open slot 
(or just double click) 
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g) Double-click on the interface module and then in the bottom window select Ethernet addresses.  Click Add 
new subnet.  Then set the IP Address for the controller in the configuration.  Then uncheck the generate 
name automatically box and set the PROFINET name to pnc1 
 

 
 
 

h) Click on the network view tab again or double-click on devices and networks. 
 

i) Install necessary PROFINET GSD files by clicking Options->Manage general station description files (GSD). 
Ensure the file(s) installed correctly.  Make sure you include the .bmp file in the same folder if you wish to 
have a graphical picture of the device.  The catalog will update after installing the files and they will be 
stored under the “Other field devices” category in the network view. 
 

4.2.2 Configuring the Device(s) 
 
The TIA Portal engineering tool supports two ways of device configuration depending on the device(s), either by 
auto or manual configuration.  Fixed or block devices with real modules / submodules can typically be done with the 
method of choice, and the easiest is auto configuration.  Some devices like proxies or gateways with ‘virtual or 
dynamic modules’ may dynamically set the configuration at start time, and legacy devices may also not be auto 
configurable.  

 
 
 
 
 
 

Edit your IP addresses, 
PROFINET name and more 
under the properties in the 
device view 
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4.2.2.1 – Auto device configuration 
 

1. Prior to starting auto configuration make sure the correct GSD file for the device(s) has been installed 
(see section ‘i’) 

 
2. Go into the network view in the project you created with the controller 
3. Next click online-> Hardware detection -> PROFINET Devices from network 
 
4. In the next window select the correct network interface on your PC and click ‘Start search’ 
 

 
 

5. The devices should now appear in the window.  Select the device(s) you want to add and click add 
devices. 

 

 
 

 
6. After a few moments the engineering tool will scan and attempt to add the devices to the project 

including their head module and IO modules.  The tool will inform whether it was successful or not (if a 
problem occurs see the output log on the issue)  In case of a problem device, we suggest a manual 
setup (see section 4.2.2.2). 
 

7. Once device information is read it will now show up to the network view.  Make sure all the modules 
have been setup and parameterized correctly in the device view.  Some devices need a parameter set, 
or there may be optional parameters like diagnostics, substitute values, etc. 

 
8. Next, continue to item ‘j’ right after the manual device configuration section (Back in the network 

view,…) 
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4.2.2.2 – Manual device configuration 
 

Example Device configuration: Manual configuration of ET 200SP module   
 
1.  Drag and drop device from catalog under Other field devices->I/O->Siemens AG->ET 200SP->IM 

155-6 PN ST V1.0 (GSD was already installed as mentioned in section ‘i’) 

 
 

2. Click “not assigned” on the device picture and assign to the controller by selecting the controller name 
and network name, once connected there should be a dashed green line between controller and 
device. 
 

3. Double click on the device to enter device view and configure the IP address (if needed) and device 
name (under properties->Ethernet addresses) and modules (in this case we have a modular device).  
We have an input module, an output module and server module to configure in our sample.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

a.) Insert the device 
head module (for 
modular device) 

b.) Assign device 
to the controller 
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4. Drag and drop the modules under the module folder from the hardware catalog to match the device. 
 
Slot 1 contains a 8DI HF V1.0 module -> select from Modules-> DI->DI 8x24VDC HF 
Slot 2 contains a 16DQ ST V1.0 module -> select from Modules->DQ->DQ 16x24VDC/0.5A STV1.0 
Slot 3 contains a server module -> select from Modules->Server Modules->Server module (0 bytes) 

 

   
5. Make sure to set any needed parameters for the modules under properties->module parameters (such 

as power settings, diagnostics, etc.)  For our particular setup we need to enable “New Potential Group” 
parameter (under module parameters) on the DI module Potential group setting in order for the device 
to work. 

 
j) Back in the network view, make sure that the devices are attached to the controller by left clicking on “not 

assigned” on the device and select the controller. Also double-check that all the modules have been setup 
and parameterized correctly in the device view. 
 

k) Click each PROFINET IO Device in the network (or device) view and go to properties->Ethernet addresses 
to display its properties and set the Device Name. All PN devices must have a unique device name. The 
device name must match the name in the physical device. Downloading a name to an IO device is 
described later.  
 

l) Note: when the IO controller starts communication with the IO device, it will find the device by name and 
then automatically set the IP address to this configured value using PROFINET DCP (Discovery and 
Configuration Protocol), unless you disable automatic name setting via the controller. (some devices may 
also support DHCP) 
 

Insert device IO 
Modules from the 
device catalog 
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m) A note on Update times – by default the minimum PROFINET update time for PROFINET Commander is  

32 ms on Windows systems even though some IO devices might be able to go faster. In most cases the 
update time should work at 32 ms, but in case of heavy system loading / running with a VM /  or many 
devices there could be an interruption of the IO tasks causing the device to display IO device offline / online 
continuously in the alarm display.  The update time can be adjusted if necessary up to 512 ms for each 
device under the properties of the device and advanced options -> real time settings -> IO Cycle.  Set to 
“Can be set” and at the specified rate.  Also note the IO display update rate setting in the PROFINET 
commander options screen (described later in the options section) should match or be higher than the 
fastest device update time.   
 

 
 

n) Make sure to use correct device GSD files and the proper FW, SW revisions if needed for head modules and 
modules, (some devices are not backwards compatible or can use substitute modules, check with vendor).  
 

o) Save and compile the project HW configuration by selecting the Controller from the network view as shown.  (If 
there are errors, check the error log and troubleshooting section.)  This will create a project configuration XML 
file which will be used for import into PROFINET Commander.  If you double click on the generated file from the 
log window it will open the file location automatically.  You can then copy the configuration file to a location on 
your PC which is easy to find (ex: desktop or documents folder) 
 

 

Select 
controller 

Compile 

Double click here to open 
configuration file location 
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4.3 Download the PROFINET IO Device Names 
 
For PROFINET communication to start properly, devices must have the configured device name written to 
them. 

 
To assign PROFINET IO device names, the PC and the IO devices must be physically connected to the 
PROFINET (Ethernet) network and powered on, in PROFINET mode (some devices may have to be set via 
webpage, settings, etc).  If you can see them when browsing in the PN Browser you’re good to go.  In some 
cases, you might have to set the IP address initially with PN Browser to get into a webpage / configuration 
option, etc. 
 
There are two main ways to set the device name(s).  By either using the configuration tool or the PNBrowser 
dialog in PROFINET Commander. 

 
1. TIA Portal (see help for assigning PROFINET device names) , right click on the network in your project and 

select “Assign device name” 
 
 

In the device name dialog select the 
device you wish to assign the name to 
with the top dropdown button.  Then 
set the online access up to PN/IE and 
correct network card.  Next click 
‘update list’ and uncheck all the 
device filters.  Once you are used to 
the filters you can re-enable them.  
Find the device in the list you wish to 
set the name and highlight, then look 
at device type, click flash LED or 
check the MAC ID compared to the 
device housing.  Once you have 
confirmed the right device, click the 
assign name button to write the name 
to the device.  Now the device will 
retain the name even after a power 
cycle.   

 

 
2. Use PROFINET Commander PN Browser 

(see section 5.10) 
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5.0 Using PROFINET Commander 
 

5.1 Starting PROFINET Commander 

Start PROFINET Commander either from the Windows Desktop icon  or by selecting  
Start->Programs-> PROFINET Commander->PROFINET Commander.  
 
The software is licensed per PC and comes in “unlicensed 
mode”.  In this mode, only the PN Browser will be fully 
operational while other screens are in demo mode.  A video is 
available on YouTube showing all features.  To unlock all 
features please purchase a copy.  The license is for one PC but 
may be transferred if necessary to another machine. 
 
PROFINET Commander can be ordered at the www.PROFINET 
Commander.com web site.  
 

5.1.1 License Management 
 
Once purchased Open the license manager from Tools-
>License Management in PROFINET Commander. 
 
You have two ways to license PROFINET Commander. 
 

1.) Online Activation – upon purchase of the software you 
will receive an activation key.  If your PROFINET 
Commander PC is directly connected to the Internet you 
can activate the software online.  Simply enter your 
name, email, company, and activation key and hit the 
“Activate License” button. 
 

2.) Offline Registration – if it is not possible to put the PC online, then you will need to copy the Registration ID 
from the dialog box and paste into an email, along with your business card information, to 
customer.service@PROFINET Commander.com 
to get a license key.  After the license key is emailed to you, enter the information in the “Offline License 
Key” field and select “Offline Activate License”.  Note that Offline registrations will have the corresponding 
online Accounts disabled, so you can use offline transfer to move the license or contact support to destroy 
the license if you want to use online activation / transfers again. 
 
Once the license is valid using either method, the license dialog will automatically close, and the main 
dialog will show ‘licensed’.  If you get an error, make sure you are using the correct input and button. 

 
In addition, the license manager provides the ability to transfer the license to move to a different PC 
 

1.) Online transfer – Puts the license back on the license server.  Then you can install PROFINET Commander 
on a different PC and then Activate your license again on that PC using your activation key.  Both PCs 
need Internet access. 
 

2.) Offline Transfer Utility – The Offline Transfer utility allows the user to transfer the license between 
machines offline. To transfer the license from one machine to another, run the Transfer utility on both 
machines. Assume you want to transfer the license from machine A to B, the steps are described below. 

 

a. Install the software and run the Transfer utility on machine B (new PC). The dialog box provides a 
Registration ID.  

b. Run the Transfer utility on machine A (old/existing PC). Then, enter the Registration ID provided by 
machine B. In this step, the utility generates the License Key that encodes the current license 
status and destroys the Key on the machine. 

c. On machine B, enter the offline License Key provided by machine A and register. The license 
transfer is complete. 

http://www.profinetcommander.com/
http://www.profinetcommander.com/
mailto:customer.service@profinetcommander.com


- 16 - 

The license utilities may also be accessed via the app shortcuts PROFINET Commander -> License Utilities from 
the desktop. 

5.2 Opening the HW Configuration Export File 

 
Select the Import button or File->Import function and then use the dialog to find and open the HW Configuration 
export file that was previously generated in TIA for the IO Controller in Section 4.2 (step o).  Or select the correct 
NIC and file if using multiple NICs on the machine. 
 

 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Select NIC and then select 
configuration file or select Import 
if NIC is already correct 
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5.3 Configuration Display 
 
With a valid import configuration file, PROFINET Commander reads the hardware configuration and displays the 
configuration in a tree view in the Configuration window. The tree can be expanded to show all the configured items 
(e.g., PN Controller, PNIO devices, I/O modules, PROFINET/PROFIBUS proxies, PROFIBUS slaves). When a tree 
item is selected, its properties and I/O data are displayed as shown below.  
 

 
 

 

Device Number 
from Config

 

Configuration 
Window 

Devices 
Window 

Properties 
Window 

Alarms 
Window 

Network card 
selection 
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5.4 Setting the Run Mode to Operate 
 
After clicking the “Operate” button, PROFINET Commander functions as a PNIO controller and establishes 
communication with the PNIO devices. The Alarms window logs each device as it comes online. The I/O data and 
status is displayed in the Devices window. Note that the I/O data for all the modules under the selected tree item is 
displayed. When in Operate or Clear mode, the I/O data and status, and the alarms, are updated based on the IO 
display update (can be adjusted in options), the default is 32ms.  You can change the display format for the I/O 
using the radio buttons.  An IO Status of “GOOD” indicates the module is good.  If the status is “BAD” then check 
the configuration of the modules online versus offline.  Also check to make sure you are using the correct GSD file 
for the device. One other thing to check is that you selected the right NIC to use with the software. Note that some 
modules can be operating correctly while others might be marked “BAD” in some cases (module not plugged in a 
slot, diagnostics present, mismatched module).  The data will not be marked “GOOD” until a successful setup and 
connection with the controller (after IO comes online and modules are correct and functioning).    
   
 

  

Set Run Mode to Operate 

Controller goes to 
Operate Mode and 

Devices come online 

I/O Data and Status are 
Displayed 

Double-click cell to 
Change Output Value 

NIC Selection and import 
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5.5 Setting IO Device Outputs 
 
As shown in the previous figure, double-click a cell in the Output column of the Devices window to change the 
output.  Note that a particular output can be selected from the tree view if there are multiple output modules. The 
following dialog will appear.  Enter a value in the edit window to send constant output values to the IO device.  
Select other auto output modes (increment to count up, decrement for count down, randomize for random number 
generation, bit walk through each bit, all outputs on or all outputs off, echo for echo of input to an output) to make 
the output change from its current value each IO display rate cycle.  The IO display update rate can be adjusted on 
the options screen from 32ms to 1 second and this is independent of the PROFINET IO device cycle. (Typically the 
device update cycle should be faster or equal to the display rate) Note that there may be multiple output values in 
the display separated by spaces. Each one can be edited for the Manual mode (leave the spaces between entries). 
If auto modes are selected all of the outputs will be automatically cycled. 
 
 

 
 
Notes about Echo Input to Output –  
 
Each input or output is assigned an IO address when configuring the device(s) in TIA Portal.  You can choose what 
Input address (I) to send to the Output (Q).  For example, we could send the input starting with address 0 to the 
output starting with address 0.  The data would fit as it is 2 words (4 bytes).  If the data will not fit, it will be 
truncated.  For example, if we write the Input address 0 to Output address 4 only the first two bytes will be sent and 
the last two bytes will be truncated.   Inputs from a device can also be sent to outputs on a different device by 
selecting the different device’s output.  If sending more than one echo, you must select the first echo, then hit ok, 
then select the second input to echo, then reenter the dialog and set the 1st as before and then the 2nd echo group. 

 
 

Set Auto Output 
modes here 

Set Output value in 
manual mode 
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5.5.1 Setting IO Display Format 
 
Change the I/O display format between Hex (default), Binary or Decimal by clicking on the desired format in the 
options menu under Tools->Options. 
 
 

 
 
  

Set IO Display 
format here 
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5.7 Displaying Diagnostic Alarms 
 
When a diagnostic alarm is received from a PNIO Device, it is displayed in the Alarms window as shown below. 
Examples of the diagnostic errors that can be reported are: 

• Power supply voltage missing 

• Wire break 

• Shorted output 
A diagnostic message contains a numeric error code without any textual explanation. The text for each error code 
may be available in the GSD (General Station Description) file for each PROFINET device. This file is supplied by 
the device manufacturer and is imported into the configuration tool. At startup, PROFINET Commander reads the 
GSD files for all the devices to get text for the diagnostic error codes. The text for the diagnostic error is also 
displayed if it is available. If not, consult the manufacturer’s documentation. 
There will also be an indication of “device diagnostic” or “device offline” if a device has a diagnostic or isn’t coming 
up properly. 

 
Device Diagnostic means the device is running with the controller, but has signaled an issue. 
Device offline means the device has not started communicating with the controller. 
Run means the controller is running. 
Stop means the controller is in stop mode.

  

Diagnostic Alarm 

Error Text 
from GSD File 

(if it exists) 
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5.8 Reading Diagnostics 

 
A diagnostic alarm is sent from the IO device to the controller when an error occurs. Once the controller 
acknowledges the alarm, it is not sent again. The diagnostic information is stored in the IO device and can still be 
read until the error goes away. To read the diagnostic errors stored in the IO devices, first select a Configuration 
tree item. The diagnostics for all of the devices under the tree item selected will be read. Then select the “Read 
Diagnostics” button. 
 

 
 
The Diagnostic dialog shown below appears. Select the “Read Diagnostics” button in this dialog each time you 
want to read the diagnostics.  The diagnostics have time stamps and are listed in reverse order, with the latest 
message at the top. A blank line is inserted each time “Read Diagnostics” is selected.  
 

 
Read Diagnostics 

Stored in IO Devices 

Then Call Up Read 
Diagnostics Dialog First Select 

Config Item 
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5.9 Performing Read/Write Record Calls 
 

 
Read Record and Write Record calls can be sent to the IO Devices.  The Read/Write calls and their associated 
contents are described in the PROFINET IO Application Layer Protocol specification or vendor tools. After setting 
the run mode to Operate, select a device or I/O module in the Configuration window for which the read/write call will 
be performed. The “Read/Write Record” button will be enabled only for the devices and modules that are 
appropriate. Then select the “Read/Write Record” button.  The location of the read / write call is important.  Ex: 
head module vs ports, vs modules / submodules.  Depending on what record should be read or written to, click on 
the appropriate location in the device prior to clicking the button.  
 
 

First Select 
Config Item 

Click Read/Write  
Data Record 
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The Read/Write Record dialog shown below appears. The “Address” fields and the Input/Output buttons are filled in 
with the information from the device selected in the previous step. To do a read record, enter the “Index” of the call 
to be made (in hexadecimal) or use the dropdown menu and then select the “Read Record” button.  Most PN 
related records are already in the drop-down list.  It is also possible to read manufacturer specific records (if 
supported). 
 
 In the example the index 0xF820 specifies the call “AR Data”. The data returned from the IO device will then be 
displayed in three windows. The data bytes are displayed in hexadecimal format in the window “Read Data (hex)” 
and the character equivalents are displayed in the window “Read Data (chars)” - if any of the data is readable text, 
it will show up in this window. Many of the read record responses are decoded by the software and show up in the 
window “Read Data Description”.  
 
If there is an error returned by the read record call, it is displayed in the “Read Data Description” window. For 
example, if a particular index was not implemented in an IO device, the response would be “Feature not supported” 
or “Invalid Index”. 
Sometimes a read record call is successful but a data length of zero is returned. For example, if a read diagnostics 
call is made and there are none to report, the message “Zero length data returned” is displayed. 
 

First Enter the Index for the 
Read Record call 

Then Select the Read 
Record button 

Hexadecimal Data Bytes 
returned 

Data Description Decoded 
by Software 

Text Version of Data 
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The read and write record indices are documented in tables in the PROFINET IO Application Layer Protocol Spec. 
The table titles are: 

• Index (user specific) 

• Index (subslot specific) 

• Index (slot specific) 

• Index (AR specific) 

• Index (API specific) 
The user (vendor/manufacturer) specific index range is 0 – 0x7FFF. For example, the index 1(check GSD) is 
typically used for parameterization data that is sent to the device during startup using write record calls 
The other index tables have pre-defined codes for record calls. A few examples are: 

• 0x800C: Diagnosis, Maintenance, Qualified and Status for one subslot  

• 0x8028: Read acyclic input object – read device input acyclically, select correct input before reading  

• 0x8029: Read acyclic output object – read device output acyclically, select correct output before reading 

• 0xC00C: Diagnosis, Maintenance, Qualified and Status for one slot  

• 0xE00C: Diagnosis, Maintenance, Qualified and Status for one AR (whole device, all slots/subslots) 

• 0xAFF0: Identification and Maintenance Data 0 (I&M0) – Model #, Serial #, FW & HW revisions 

• 0xAFF1: Identification and Maintenance Data 1 (I&M1) – Device function and location 

• 0xAFF2: Identification and Maintenance Data 2 (I&M2) – Installation Date 

• 0xAFF3: Identification and Maintenance Data 3 (I&M3) – Additional Information (who to contact, support) 

• 0xE000: ExpectedIdentificationData for one AR – Configuration data 

• 0xE001: ReadIdentificationData for one AR – actual device modules (should match expected) 

• 0xE002: ModuleDiffBlock for one AR – if modules are different between real/expected it will be shown here 
(see more in troubleshooting section) 

• 0xF820: ARData for one API – PROFINET Application relation data 

• 0xF830: Logbook Data – information about any PROFINET related errors (watchdog timeout, etc.) 

• 0xF841: PDRealData – select a Ethernet port on the device before reading this, returns port specific 
information such as port info and peer information (neighbors connected and port status) 

 
If data is displayed in the “Read Data (hex)” window but is not interpreted by the software in the “Read Data 
Description” window, then you will have to decode it yourself. The read data always begins with a two-byte “Block 
Type” field. In the example the block type 0x0010 is for a Diagnosis Data block. In the PNIO spec there is a table 
entitled “BlockType” which lists the code for each block type. From there you would have to find the description of 
the block and its contents in the spec.  
 
In order to perform a write record call, enter the Index and the Write Data. Then select the “Write Record” button. 
The software will calculate the number of bytes of data and put the value in the “Write Length” field. In the example 
below the index 1 is defined in the GSD file for three bytes of parameterization data.  Other examples might be to 
write I&M data with the fields, PROFIdrive parameters, or other records which are supported by the device.   
 
Example 1:  (Writing vendor / manufacturer specific parameter data to device Index 1, 3 bytes parameter data 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

First Enter the Index for the 
Write Record call 

Second Enter the Data 

Third click the Write 
Record button 



- 26 - 

 
Example 2:  (Writing Identification and Maintenance information – I&M 1-3) 
Note that each I&M record set needs to be written separately.  For example, Select I&M1, then fill out info, click 
write record button. Select I&M2, fill out info, then click write record button and so on. 
 

,  

 
 
5.10 PN Browser 

 
The PN Browser (PROFINET browser) can be used to scan the PROFINET network for devices and get their DCP 
(Discovery and basic Configuration Protocol) information.  Set device names, set IP address, flash LEDs, reset a 
device or devices to factory settings and copy and paste the DCP data.  It will also allow setting temporary IP 
addresses and names vs a permanent setting (which must be maintained after power cycle on the device).   

 

First, Select NIC for PN 
Browser, Independent 

of Main window 

Second, use DCP 
identify all to get the 

PROFINET device 
list and info 

Device Info – 
Doubleclick to copy 

data to function section 
or select device 

DCP Functions 

Information Window 

Second select I&M record 
number from the dropdown 

(here  I&M1 – device function 
and location) 

First Enter the Data 

Third click the Write 
Record button 
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PN Browser functions:  
First select NIC and then click DCP Identify All to scan the system and build the PROFINET device list. 
Double click on a device to move info to the function section for easy editing if needed. 
 
DCP Identify All – Get all devices info and build device list. You can copy -> Paste from the device list into Excel or 
other programs if you wish to save the device information. 
DCP Identify Specific – Search for a device with a particular name (or alias name). 
DCP Set Name – Set the name on the device either permanent (default) or temporary. Permanent will be retained 
after a device power cycle while temporary will not. 
DCP Set IP Params – Set the IP on the device either permanent (default) or temporary. 
DCP Get info – Get single device info or refresh 
Start LED flash – Flash device LEDs if supported 
DCP Factory Reset / Reset to Factory – Reset device to factory settings based on Mode (Mode 0 / default clears 
all) 
Factory Reset Modes –  
 

Mode 1  Reset Application 

data 

Resets I&M data, SNMP writeable OIDs, and manufacturer specific record 

data objects 

Mode 2  Reset 

Communication 

parameter 

Resets name of station "", IP to 0.0.0.0, DHCP (if available), all PDev 

parameters (topology, etc.), and SNMP writeable OIDs 

Mode 3  Reset Engineering 

parameter 

Performs a Mode 1,2 reset + clears any engineering data (ex: 

configuration/parameters) 

Mode 4  Reset All stored 

data 

Performs a Mode 1, 2, & 3 reset 

Mode 8  Reset device Performs a Mode 4 reset to all interfaces in case the device has multiple 

interfaces 

Mode 9  Reset and Restore 

Data 

Same as mode 8 + resets installed software images back to factory 

default 

Mode 0 Factory Reset 

(default)  

 

Factory Reset Performs mode 1/2 reset 
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5.11 Configure Controller  

 
If the TIA Portal software is loaded on the same machine as PROFINET Commander this button or menu item can 
be used to open the configuration tool.  If the tool is not found, you can try using the alternate configuration tool file 
location option from the options menu. 

5.12 Options menu 
 
The options menu lets you adjust some of the PROFINET Commander settings.  Note that the tool needs admin 
rights for settings to work (default). 
 

 
 
IO Display Format - IO Display format can be changed between Hex (default), Decimal and Binary. 
 
Alternate Configuration Tool File Location – Alternate location to look for TIA Portal configuration tool, or 
different tool. 
 
Additional GSD Folder Location – Tool will scan for GSD files in the TIA Portal default folder and PROFINET 
Commander folder.  If you have a different location, place it here. 
 
PN Browser DCP Timeout (ms, 1200 -30000) – This is the time the PN Browser will listen for a DCP response 
when using DCP commands like set name, identify, set ip, etc.  Default is 1500 ms.   
 
Skip DCP Identify after set – Normally the configuration tool will refresh the PN device list after a set or reset.  If 
you want to skip this (faster) then enable this setting. 
 
Save Network interface selections on exit – The main commander and PN Browser NIC selections can be saved 
on exit and are independent of each other. 
 
IO Display Update Rate -  
The IO display update rate for the IO display pane can be adjusted between 32ms and 1 second for reading / 
writing the IO.  This is independent of the PROFINET IO device update times and should be equal or slower than 
your PROFINET device(s).  If set at fast update rates it is possible there may be some screen flicker due to the 
continuous updates of IO data.  The display can be slowed down to remove the flickering if needed. 

 
Update Manufacturer ID Table – This will attempt to download the latest manufacturer ID table used by the DCP 
browser if you have a valid Internet connection, otherwise you can download manually and copy to the main app 
folder from the https://www.profibus.com/IM/Man_ID_Table.xml website. 
 
 
 
 
 
 
 
 
 

https://www.profibus.com/IM/Man_ID_Table.xml
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6.0 FAQ / Troubleshooting 
 
As we get common questions, we will offer a FAQ and troubleshooting tips here: 
 
TIA Configuration Software lists a “Compile Error” without any details – This usually means that the XML File 
in use by PROFINET Commander can’t be overwritten.  If you are compiling, shut down PROFINET Commander 
prior to compile or copy the XML file to a different location each time (ex: Desktop) 
 
When importing the XML file I get the error ‘invalid configuration’ or ‘invalid file argument’ 
This means that your TIA Portal configuration is invalid or you are using the wrong file type.  Typical reasons 
include not putting the device in the configuration and attaching to the controller, only the controller.  Or another 
reason might be that you are importing the wrong file (for example a device GSDML file) instead of an actual 
configuration file.  If you still have trouble after checking these items see the manual for a configuration example or 
contact support. 
 
PROFINET Commander won’t start or immediately closes – Double-check the dependencies from the 
installation section.  Double-check for a valid license or if another window appears (license window).  Make sure 
you have selected the right network interface for the communications.  Note Wireless and loopback adapters will 
not work. 
 
Device isn’t coming up (always offline) - Make sure you have set the controller to operate mode. Check that the 
name has been set and you can see the device with the PN browser.  Note that the configuration tool “display” 
name and device name may not match.  You can see what the actual name should be by clicking on the device in 
commander and viewing its properties or looking in the engineering tool at the PROFINET device name setting in 
the devices properties.  Try to set the update time to the slowest value in the engineering tool (512ms). Also ensure 
that there is no firewall/antivirus/malware scanner on the PC which could block the communications (port 34964 
and Ethertype 0x8892 should be possible).  Usually Windows Firewall is OK, but if there is another firewall it should 
be disabled or an exception set.  Check that you have selected the right network interface for communications. 
 
Device always shows a diagnostic or error – See if alarms window shows any information. Check that you have 
configured the device and modules properly with the correct fw and revision.  Highlight the device and under 
read/write record read the diagnostics (0xF80C) to determine the error (or see alarm info).  Also, you can see the 
module diff block record (0xE002) to determine what modules might not be configured properly.  
 
Device keeps going online then offline continuously – check the update time set on the device(s).  As Windows 
is not a real time OS, some other tasks could interrupt PROFINET communications at fast update times.   Set the 
device(s) to 512 ms and try again as a test, and then you can adjust down incrementally to see what works best on 
your system to a minimum of 32 ms.  You can also try to figure out what tasks are running simultaneously and 
close other programs you don’t need to see if that helps. 
 
Diagnostic LED in commander never turns off – this can happen if there was a preexisting diagnostic prior to 
the startup on a device and is a known issue.  Fix the diagnostic issue on the device and then stop and start the 
controller again to clear it.  We are planning a fix in a future version. 
 
The diagnostic alarms from the device(s) are only showing a number, no text - This can happen if the GSD 
files cannot be found on your system in the TIA GSD, PROFINET Commander GSD or user supplied (in options) 
folders.  Make sure the GSDs for the devices are located on your system and you are running the software with 
Admin rights.  Also make sure the GSD file name conventions are correct as it helps the tool find the correct GSDs. 
 
The device keeps sending a remote mismatch error and clearing the error and it’s right beside the PC - 
If you have configured a topology-based system for diagnostics testing or device replacement the device is 
signaling an error because the PC is likely sending multiple LLDP messages (like Windows LLDP + PROFINET 
info) and confusing the interface.  Be sure to disable other LLDP protocols under your network adapter settings.  
LLDP is already built into the PROFINET Commander driver. 
 
Do I need a separate license for TIA Portal configuration tool? – No, PROFINET Commander only needs one 
license because it uses the PN Driver object in TIA Portal.  This is considered a “PC Station” and does not require 
an additional license for TIA.  TIA requires a license if programming Siemens PLC’s (like S7 1500, 1200, 300 / 400, 
etc.). 
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Will PROFINET Commander work while plugged into a switch monitor (mirror) port? 
No, connecting to a monitoring port on a switch causes duplicate frames to be sent to the driver and this can cause 
communication issues.  A switch port monitor is not supported at the same time.  Disable any monitor ports on the 
switch prior to running PROFINET Commander. 
 
Under my NIC selections it just shows “Microsoft” on my adapters? 
In some special cases, this is an issue coming from the underlying drivers when requesting the NIC information.  In 
this case, you should try each selection where Microsoft is listed and see which card it applies.  Once you find the 
correct card you can turn on ‘save NIC selections’ under the options menu to save the setting. 
 
When starting the controller (online/run) I get ModDiffBlock was detected?   
A ModDiffBlock can mean multiple things.  A mismatch between the actual device configuration and the offline 
configuration (fw rev not matching, missing modules / submodules, wrong modules / submodules) and/or that the 
device is locked by another controller / process and/or that there could be an active (in place) diagnostic.  Select 
the device in question and enter the R/W Record dialog.  Read record 0xE002 (Module Diff block for one AR) to 
see what modules / submodules have the issue and then correct the underlying problem.  A substitute 
module/submodule is usually OK (probably a firmware difference, check the GSD file and versions) and the device 
will continue normal operation even with the ModDiffBlock; however, a wrong or missing (unplugged) module will 
not work until corrected.  Check your configuration if a wrong module and change the device configuration or check 
real hardware if a module is missing, not plugged in.  If a diagnostic is detected you can read diagnostics to attempt 
to get more info or check the alarms/info pane from the main window display.  If the device is locked by another 
controller it means that no more than one controller has access to the device at a time, check shared device 
settings if trying to setup ‘shared device’ in the device configuration.  Note that sometimes a ModDiffBlock may be 
incorrectly signaled with a device under development if the modules are not plugged into the device firmware / 
stack correctly.  Or sometimes this may happen with gateways / proxies if they are using virtual modules or are not 
ready for startup.   
 
The software keeps stating “not a valid adapter” or similar?   
Make sure to select a valid adapter prior to importing and starting the controller or browsing the network.  If network 
adapters have changed in the meantime restart the software and try again.  If you are using a USB adapter this 
may require restarting the Npcap service.  Start a command prompt with admin rights and type net stop npcap then 
hit enter.  Then once the service stops type net start npcap and enter again. Then restart PROFINET commander 
and try again.  Make sure the adapter in question works with Wireshark as well.  (also check the next tip if still not 
working) 
 
How to get the latest software updates? – To use the automatic update feature a license and Internet connection 
is required.  The software will check the server at startup if an update exists and notify the user if so with a dialog.  
Another way to get the update is to manually download the latest (free) version from the website.  Install the latest 
free version and the license will be detected and all updates activated.   
 

7.0 Further support 
If you need further information, have questions, or need technical support on PROFINET Networking Technology or 
PROFINET Commander please visit the PROFINET Commander website at http://www.profinetcommander.com,  
E-mail pic.industry@siemens.com or call +1-423-262-2576 and ask to speak with someone from the PROFI 
Interface Center. 
 We can assist with most questions relating to PROFINET Commander and the configuration or inquiries 
about PROFINET Networking technology or development. If you have product specific questions related to a 
particular vendor’s product then contact their hotline or technical support personnel.  We do not provide product 
GSD files and these would need to be obtained from the vendor. 
 
Finally, we also offer training classes in conjunction with PI North America.  The classes are vendor neutral, and 
technology focused with a lot of hands on with real world experience and examples rolled in.  During the class we 
also use the PROFINET Commander PRO version for learning labs. 
https://us.profinet.com/training/profinet-courses/ 

http://www.profinetcommander.com/
mailto:pic.industry@siemens.com
https://us.profinet.com/training/profinet-courses/

